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NEW QUESTION 1

SIP IP
Phone UserA SIP IP

Phone UserB SIP IP
CUCM

Phone User C

Refer to the exhibit. In an active SIP call between phone user A and phone user B, phone A initiates a call transfer to phone user C. Which two scenarios are
correct? (Choose two.)

A. Phone_A sends a SIP-REFER message to the Cisco Unified Communications Manager with Phone_C information in the Refer-To section.

B. Phone_B sends a SIP-REFER message to the Cisco Unified CM with Phone_C information in the Refer-To section.

C. As soon as Phone_A presses the Transfer button for the first time, Phone_B hears the MOH and the MOH audio is chosen from Phone_B User Hold MOH
Audio Source settings.

D. As soon as Phone_A presses the Transfer button for the first time, Phone_B hears the music on hold and the MOH audio is chosen from Phone_A Network
Hold MOH Audio Source settings.

E. As soon as Phone_A presses the Transfer button for the first time, Phone_B hears the MOH and the MOH audio is chosen from Phone_A User Hold MOH
Audio Source settings.

Answer: AC

NEW QUESTION 2

The administrator of ABC company is troubleshooting a one-way audio issue for a call that uses H.323 protocol (slow-start mode). The administrator requests that
you provide the IP and port information of the Real-Time Transport Protocol traffic that had the one-way audio call.

You gather the H.225 and H.245 messages for one of the one-way audio calls. Where can you find the RTP IP and port information for both sides? (Note: This call
flow has not invoked any media resources like MTP or transcoders).

A. H.245 Terminal Capability Set

B. H.245 Open Logical Channel

C. H.225 Connect

D. H.245 Open Logical Channel Ack

Answer: B

NEW QUESTION 3
Which two extended capabilities must be configured on dial peers for fast start-to-early media scenarios (H.323 to SIP interworking)? (Choose two.)

A. DTMF
B. BFCP
C. VIDEO
D. FAX
E. AUDIO

Answer: AB

NEW QUESTION 4

When you troubleshoot H.323 call setup, which message informs you that the called party is being notified about the call?
A. ALERTING

B. PROCEEDING

C. CONNECT

D. RINGING

Answer: C

NEW QUESTION 5

Why would RTP traffic that is sent from the originating endpoint fail to be received on the far endpoint?

A. The far end connection data (c=) in the SDP was overwritten by deep packet inspection in the call signaling path.
B. Cisco Unified Communications Manager invoked media termination point resources.

C. The RTP traffic is arriving beyond the jitter buffer on the receiving end.

D. A firewall in the media path is blocking TCP ports 16384-32768.

Answer: D

NEW QUESTION 6

What is first preference condition matched in a SIP-enabled incoming dial peer?

A. incoming uri
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B. target carrier-id
C. answer-address
D. incoming called-number

Answer: A

NEW QUESTION 7

Cisco SIP IP telephony is implemented on two floors of your company. Afterward, users report intermittent voice issues in calls established between floors. All calls
are established, and sometimes they work well, but sometimes there is oneway audio or no audio. You determine that there is a firewall between the floors, and
the administrator reports that it is allowing SIP signaling and UDP ports from 20000 to 22000 bidirectionally. What are two possible solutions? (Choose two.)

A. Go to the SIP profile assigned to these IP phones in Cisco Unified CM and change the range of media ports to 16384-32767
B. Ask the firewall administrator to change the ports to TCP.

C. Ask the firewall administrator to change the range of UDP ports to 16384-32767.

D. Go to the SIP profile assigned to these IP phones in Cisco Unified CM and change the range of media ports to 20000-22000.
E. Go to System Parameters in Cisco Unified Communications Manager and change the range of media ports to 20000-22000.

Answer: AC

NEW QUESTION 8
Which section under the Real-Time Monitoring Tool allows for reviewing the call flow and signaling for a SIP call in real time?

A. Analysis Manager > Inventory > Trace File Repositories

B. System > Tools > Trace and Log Central

C. Voice/Video > Session Trace Log View > Real Time Data

D. Voice/Video > Session Trace Log View > Open From Local Disk

Answer: C

NEW QUESTION 9
A company has an SRST gateway running an I0S XE image. The company plans to enable the IPv6 addressing companywide. To enable the IPv6 in a unified
SRST gateway to support SIP phones, what are two supported supplementary features for an IPv6 fallback scenario? (Choose two.)

A. three-way conference
B. secure SIP lines

C. T.38 fax relay

D. transcoding

E. SIP trunk

Answer: AC

NEW QUESTION 10
You see the voice register pool 1 command in your Cisco Unified Communications Manager Express configuration. Which configuration is occurring in this
section?

A. configuration for a single SIP phone

B. configuration items common for all SIP phones

C. configuration for a pool of SIP phones (similar to device pool on Cisco Unified Communications Manager)
D. configuration for SIP registrar service

Answer: C

NEW QUESTION 10

Which top-level IOS command is needed to begin the configuration of a Cisco Unified Communications Manager Express gateway to enable phones to be
registered via SIP?

A. allow-connections sip to sip

B. voice service voip

C. voice register global

D. voice register dn

Answer: C

NEW QUESTION 12

For s SIP to SIP call flow, when does Cisco Unified Border Element require transcoding resources for DTMF?
A. interworking between an OOB method and RFC2833 for flow-around calls

B. interworking between h245-signal and rtp-nte

C. interworking between an OOB method and RFC2833 for flow-through calls

D. interworking between h245-alpha numeric and sip-kpml

Answer: A

NEW QUESTION 15
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volca translation-profile incoming
translate called 555
1
volce translation-rule 999
rule 1/% (*[1-=2] [1-2] [1-2]1\ )} 333\ ([4-5]1 [4-=-5] .\) & / / \2333\1/
!
dial-peer voice 999 wvoip
translation-profile cutgoing incoming
gassion protocol sipv:
incoming called-number
dtmf-relay rtp-nte
codec transparent
destination dpg 888
no vad
!
voice class dpg 888
dial-pear 888

1

dial-peer voice 888 voip
destination-pattern 888
session protocol sipw2
gegsion target ipv4:192.1e8.0.1
codec Cransparentc
dtmf-relay rtp-nte
na vad

Refer to the exhibit. Calls incoming from the provider are not working through newly set up Cisco Unified Border Element. Provider engineers get the 404 Not
Found SIP message. Incoming calls are coming from the provider with called number “222333444” and Cisco Unified Communications Manager is expecting the
called number to be delivered as “444333222". The administrator already verified that the IP address of the Cisco Unified CM is set up correctly and there are no
dial peers configured other than those shown in the exhibit. Which action must the administrator take to fix the issue?

A. Change the destination-pattern on the outgoing dial peer to match “444333222".

B. Set up translation-profile on the incoming dial peer to match incoming traffic.

C. Create specific matching for “222333444” on the incoming dial peer.

D. Fix the voice translation-rule to match specifically number “222333444” and change it to “444333222".

Answer: B

NEW QUESTION 16
A user in location X dials an extension at location Y. The call travels through a QoS-enabled WAN network, but the user experiences choppy or clipped audio.
What is the cause of this issue?

A. missing Call Admission Control
B. codec mismatch

C. ptime mismatch

D. phone class of service issue

Answer: B

NEW QUESTION 19
An engineer must route all SIP calls in the form of <user>@example.com to the SIP trunk gateway corporate local. Which two SIP route patterns can be used to
accomplish this task? (Choose two.)

. example.com@gateway.corporate.local
. *@example.com

. gateway.corporate.local

. example.com

* *

moowm»

Answer: BE

NEW QUESTION 21
Which two statements are correct with respect to the Client Matter Code setting in the route pattern configuration? (Choose two.)

A. The Client Matter Code feature does not support overlap sending because the Cisco Unified CM cannot determine when to prompt the user for the code.

B. If you check the Allow Overlap Sending check box, the Require Client Matter Code check box becomes disabled.

C. If you check the Allow Overlap Sending check box, you can also check the Require Client Matter Code check box.

D. The Client Matter Code feature does support overlap sending because the Cisco Unified Communications Manager can determine when to prompt the user for
the code.

E. The Client Matter Code has the option to configure Authorization Level such as in the Forced Authorization Code.

Answer: AB

NEW QUESTION 23
In Cisco Unified Communications Manager, which tool do you use to check SIP traces?

A. MTP

B. CCSIP

C. RTMT

D. OS Administration Page

Answer: C
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NEW QUESTION 27
If all patterns below are configured in Cisco Unified Communications Manager which would be used when dialing the pattern “123"?

A. 12!

B. 12X (urgent priority set)
C. 1XX (urgent Priority Set)
D. 12[2-5]

Answer: B

NEW QUESTION 28
The Cisco Unified Communications Manager Dialed Number Analyzer allows analysis of calls from which two devices? (Choose two.)

A. translation patterns
B. device pools

C. CTI ports

D. CTI route points

E. IP phones

Answer: CE

NEW QUESTION 30
In Cisco Unified Communications Manager globalized call routing is implemented and must confirm that it is correctly implemented without making a call. Which
tool do you use for verification?

A. Dialed Number Analyzer
B. Real-Time Monitoring Tool
C. SDI trace

D. SDL trace

Answer: A

NEW QUESTION 35
How does an engineer globalize routing for ingress calls coming from the PSTN to internal DNs?

A. At the PSTN gateway, put the calling number in PSTN format and the called number in DN format.

B. At Cisco Unified CM, put the calling number in E.164 format and the called number in PSTN format.

C. At the PSTN gateway, put the calling number in E.164 format and the called number in localized (DN) format.

D. At Cisco Unified Communications Manager, put the calling number in E.164 format and the called humber in E.164 format.

Answer: B

NEW QUESTION 38
Which call pickup feature allows users to pick up incoming calls in a group that is associated with their own group?

A. Other Group Pickup
B. BLF Call Pickup

C. Group Call Pickup
D. Directed Call Pickup

Answer: A

NEW QUESTION 42

An administrator is configuring a cluster for ILS and wants to limit the amount of entities that Cisco Unified Communications Manager can write to the database for
data that is learned through ILS. Which service parameter is used to adjust this limit?
A. ILS Max Number of Learned Objects in Database

B. ILS Active Learned Object Upper Limit

C. Global Data Service Parameter Limit

D. Imported Dial Plan Replication Database Object Lower Limit

Answer: A

NEW QUESTION 44

What is a component of Cisco Unified Mobility?

A. Unified IVR

B. Mobile Connect

C. Smart Client Support

D. Single Number Connect

Answer: B

NEW QUESTION 46
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What are the elements for Device Mobility configuration?

A. physical location, device pool, and Device Mobility group
B. device pool, Device Mobility group, and region

C. physical locatio

D. Device Mobility group, and region

E. device pool, Device Mobility group, and Cisco IP phone

Answer: A

NEW QUESTION 47
Which services are needed to successfully implement Cisco Extension Mobility in a standalone Cisco Unified Communications Manager server?

A. Cisco Extended Functions, Cisco Extension Mobility, and Cisco AXL Web Service
B. Cisco CallManager, Cisco TFTP, and Cisco CallManager SNMP Service

C. Cisco CallManager, Cisco TFTP, and Cisco Extension Mobility

D. Cisco TAPS Service, Cisco TFTP, and Cisco Extension Mobility

Answer: C

NEW QUESTION 52
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